Basics Lesson Two – Controlling Windows with Mouse Keyboard and Start
Using a Mouse
 The Mouse controls the movement of the POINTER or CURSOR, or "Drags" something.
o A Pointer looks like an Arrow

.

o A Cursor may be an Hourglass or circling arrow (Computer "brain" is busy), a Hand










,

or an I‐beam , Tool type such as a two‐directional
or four‐directional arrow
depending on the program and location. We will discuss this further in upcoming
lessons.
o Using the left or right mouse buttons involves "clicking" and "dragging."
There are two buttons on the mouse, a left mouse button and a right mouse button, and
between those buttons, a wheel.
Using a wheel
o Rolling the wheel scrolls up or down a page.
o On some, the mouse properties (Control Panel) can be set to scroll horizontally as well.
Clicking ALWAYS refers to a left‐click.
o If a right‐click is intended, instructions say right‐click.
o Click is all that is needed if it is intended to be a click with the left mouse button.
Depressing the left mouse button begins what is call a (mouse) CLICK.
o A mouse click consists of pressing down the mouse button, AND releasing it.
o Nothing happens (the click is not completed) until the mouse button is RELEASED.
o If you do not want something to happen, just move the mouse pointer away before
releasing it.
DOUBLE‐CLICKING
o Consists of clicking the left mouse button twice in rapid succession.
 Can’t seem to double‐click? Use a single click, followed by hitting the ENTER key.
It accomplishes the same thing. The ENTER key acts as the second click.
 The speed necessary between clicks in order to accomplish a double‐click is
adjustable in the Control Panel.
o If in doubt about whether to Double‐click, always try a Single‐click first. Wait a few
seconds. If nothing happens, then try double‐clicking instead.
o Double‐click timing can be adjusted using the Control Panel | Mouse (see below).
RIGHT‐CLICKING
o Depressing the right mouse button begins a Right‐click. Again, if EVER someone wants
you to click the right mouse button they include the word right. They do not include the
word left when requesting a click of the left mouse button, it is implied by the absence
of the word "right".
o Right‐clicking on an object or blank area opens a Menu (referred to as a "right‐click
menu, or "context menu") of possible functions you can perform for that item. That
menu displayed changes depending on what you right‐click on (or over).
o Use a right‐click (click on the right mouse button) only when you wish to bring up the
"context" menu. Right‐click only to display the menu of choices.
o Always "click" (remember that is with the left mouse button, never right‐click) on one of
the menu choices to "execute" that choice (cause the desired action to occur).
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Laptops have a Touchpad, a rectangular area in front of the keyboard, which acts as a mouse.
o The touchpad can be used in lieu of, or in combination with a mouse.
o Two varieties of touchpad are used.
 One variety has the rectangular area only, divided into three regions, the pad, a
left mouse button, and a right mouse button area.
 The second variety has a separate dedicated mouse buttons, left and right, just
above or below the rectangular touchpad.
o The touchpad works by sliding the finger around the pad, which moves the cursor or
pointer just as it does with a mouse
o A click is performed by either pressing down on the left mouse button area (the lower
left part of the pad if not dedicated button); or simply by gently tapping on the
touchpad.
o A right‐click is performed by pressing down on the lower right side of the touchpad (if
no designated right mouse button is included).
o The Touchpad, unlike the mouse, has more functions, referred to as "Gestures".
 Scroll by placing two fingers on the touchpad and stroking up, down, or across.
 "Pinching" can zoom in or out on web pages, documents, pictures, etc.
 Place two fingers on the touchpad and move them wider apart to zoom in.
 Similarly, moving the two fingers closer together zooms out.
 The touchpad is capable of as many as ten finger recognition for specialized
functions as well.
 Drag a finger from off the touchpad onto it from the right to open the edge
functions.
 Drag a finger from off the touchpad on the left to switch applications.
 Refer to the Control Panel item Mouse | Settings for more instruction on use of
the touchpad.

2

Basics Lesson Two – Controlling Windows with Mouse Keyboard and Start


DRAGGING and DROPPING
o Dragging for purposes of making a "selection", consists of starting with the cursor
(mouse arrow) "hovering" over (or at the front of) the item or text; now hold the
left mouse button down; while continuing to hold the mouse button down, drag the
cursor to the desired position (end of text or items) before releasing the mouse button.
That "selection" should turn a different color (blue, gray, yellow, or even black), to verify
it has been selected.
o Dropping refers to leaving an object such as an icon, a file, or a folder at the location is
was dragged (above) by letting go of the mouse button. Again, start with the cursor
(mouse arrow) over the item (object); hold the mouse button down; while continuing to
hold the mouse button down, drag the object to the desired position; let up on (release)
the mouse; the object will have been moved from the first location to (dropped at) the
second location.
 Dragging and dropping can be performed with either the left mouse button or
the right, but with different results.
 Using the right mouse button to drag an object produces a menu
following the "drop", which asks whether you wish to Move the object,
Copy the object, Create a shortcut to the object (in the new location), or
Cancel (meaning you didn’t mean to drag it in the first place).
o Playing games like Solitaire or Hearts is good practice for using the mouse. You can
practice clicking, dragging, right‐clicking, and even double‐clicking while playing the
games.
o Dragging and Dropping can be performed from the touchpad or touchscreen as well.
 Double‐tap the item you wish to drag, but do not lift the finger off after the second
tap.
 Now the object will move as the finger moves to the desired location.
 Simply lift the finger when the position is reached.
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Keyboard Essentials:
 Two basic keyboard layouts exist.
o Standard Desktop Keyboard consists of four areas.

1. A Typewriter‐like "character" section (the primary area of the keyboard seen
above) is used to write letters, numbers, and typical characters (@, #, &, etc.)
just like a typewriter (using the SHIFT key to get the upper characters shown on
the key).
2. The Numeric keypad (underlined in red on the right)
provides an adding machine/calculator‐like layout for
rapid insertion of numbers and performing calculations
(if you are working in a calculator type program).
3. An Arrow key section with other special keys (Insert,
Delete, Home, End, Page up, and Page down
underlined in blue) is used to move about within
programs, windows, or text.
4. Above the character keys is a row of keys labeled F1, F2, F…through F12. This is
referred to as the Function key bar. It handles special functions dependent on
the program being used (as examples, F1 brings up Help, and F7 initiates spell‐
check during word processing).

o Non‐standard keyboards (those purchased special, or sometimes provided with the
computer purchase) may have additional "multi‐function" keys, such as keys which
control volume, perform CD/DVD‐ROM functions, or load mail, Internet, calculator, or
other programs. Still the standard layout persists.
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Laptop keyboards are more varied in location of various keys, but the four main functions
described above are achievable.
o At first glance, the keyboard consists of only the Typewriter (character) keyboard; but
on a second examination, you see some keys on the laptop have additional markings.
These keys have multiple purposes.

Keyboard
areas
1. F keys
2. Characters
(most keys)
3. Numeric
4. Insert /
Delete
Home/End
Page up /
Page down
Arrow

o These multi‐purpose keys have those addition functions marked in blue, gray, or the
keys have another contrasting appearance (such as a white background with black
characters).
o In order for the key to perform the "blue" function (such as the numeric keypad
function), a special key present only on laptops, and found usually between the CTRL
key and the ALT key on the left, is required to be
held down simultaneous while striking the
special purpose key.
o This special "function" key is usually marked by
the same color or appearance (blue, gray, or
other color markings) as the multi‐purpose keys.
o It may also have the label "Fn", or the manufacturer logo, and is
located in the bottom row, between the left CTRL (control) key and the
Windows Logo key or ALT key.
 This also means if any other typical keyboard combination
(such as Windows logo key + Pause) and the Pause is one of the blue function
keys, both the Windows logo key and the "Fn" key need to be held down
simultaneously while the "blue" Pause key is struck.
 Laptop keyboards also possess the Function key area (see the diagram above).
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Important keys on a Keyboard
 CTRL key
o In combination with other keys (you will learn about the combinations later), it performs
various operations.
 ALT key
o Similarly, in combination with other keys, it initiates various commands.
 ENTER key
o Initiates any highlighted or mouse chosen command.
o Also, during e‐mail and word processing, it starts a new line (or in other words, new
paragraph). It is not necessary to use at the end of every line, only paragraphs. The
words in a sentence move to the next line automatically. It is called "Word Wrap."
 WINDOWS LOGO key (looks like four closely bunched rectangles) and is located between the
left CTRL key and the left ALT key.
o Again, in combination with other keys, it initiates various commands, or opens a
window.
 ESC key (top left‐most key on the keyboard)
o Use to sometimes end a computer activity. This is not used to "close" a program
typically.
 DEL key
o DEL means Delete; thus use this key to delete whatever you have "selected."
 INSERT key
o INSERT key has no special function except with certain programs, which we will discuss
in the next lesson.
 ARROW keys
o Move the "cursor" around (up, down, and sideways) in a word processor.
o Move up or down, or side to side, in menus.
 HOME
o Has special function to be learned about later.
 END
o Has special function to be learned about later.
 Page UP
o Has special function to be learned about later.
 Page Down
o Has special function to be learned about later.
 PRNT SCRN
o Has special function to be learned about later.
 PAUSE
o Has special function to be learned about later.
 NUM LOCK
o Depressing makes the numbers on the numeric pad to the right of the character
keyboard active (displays numbers when typed). It usually causes a light to appear,
either in the key, or elsewhere on the keyboard.
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Laptops and many premium keyboards have a special "Blue" (gray, white or otherwise
demarcated) Function key ("Fn"). It is usually between the CTRL and ALT keys. It "activates"
the "blue"(or otherwise demarcated) function on other laptop keys.
NUMERICAL KEYPAD
o The Adding Machine‐like group of keys on the right side of traditional full keyboards.
o Laptops do not have this grouping to the right, but instead some laptops mingle them
within the character keys (around the j‐k‐l cluster usually demarcated by a color, blue,
gray, or similar to the "Fn" key color).
 This feature is rapidly disappearing, as Windows 10 has minimized the number pad's
importance.
FUNCTION keys (F keys at the top of the keyboard)
All the other keys (letters, punctuation, TAB, SHIFT, CAPS LOCK, and numbers) are basically
similar to a typewriter.
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If having difficulty using the mouse:
 Remember, any movement as you click, right‐click, or double‐click interferes with (prevents)
recognition of the function requested.
o May not be recognized at all, or may bring up different (unexpected) menus
 If using a mouse proves impossible, consider a Trackball.
o It allows the ball to be moved by the fingers or thumb independent of the mouse.
 There are changes available in the Control Panel/Mouse which can improve individual
performance, specifically customizing:
o Double‐click recognition
o Cursor size and visibility
o Orientation, Wheel, and or Touchpad function
A few quick Keyboard points:
 A few very basic keyboard key functions
o The ENTER key creates a new paragraph (jumps to the next line
o Do not confuse this with a typewriter "Return" function.
 No key needs to be used to get the text to move to the next line. It does so
automatically (referred to word‐wrap)
o TAB, SHIFT, CAPS LOCK, AND SPACE BAR act just like they do on a typewriter.
 You can learn about special tab features on a computer later.
o The NUM LOCK key toggles (turn on or off) the activity of the numeric keypad of the
desktop keyboard.
 Ideally, laptops have a Num Lock key which makes the "blue" numeric keys
remain active, but in my experience, some laptop’s Num Lock seems to have
little effect other than lighting the num lock light. In that case, to use the
numeric keys the Fn key must be held down, as required if desiring only a single
use of the key.
 We will discuss more keyboard key functions as we discuss and use programs.
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A few quick general points:
 When the computer is off, simply pressing the Power button allows Windows to start up.
 Windows will go on to "load" leaving you either at the desktop, or depending upon your
configuration, may first greet you with the Welcome Screen and need to click on the User
Name, and/or put in a password before finishing loading to the Desktop.
 Windows has multiple ways to perform most tasks, Menu bar menus, right‐click menus, and
keyboard shortcuts; these choices are provided to improve efficiency. Do not get confused
trying to learn all the different methods. Get accustomed to the one way that works best for
you first.
 When instructions say hit ANY key, they mean literally any key on the keyboard. There is no
key specifically marked ANY, nor is any particular key considered the "ANY" key.
 Pressing the Power button while Windows is running usually just initiates Windows shutting
down (turning off). This function can be changed if desired. If it doesn't shut down, but goes
blank, it probably went into "Sleep" mode (computer is in Standby mode, waiting for you to
wake it up with a keystroke or mouse movement).
o Earlier Windows versions warned against using the Power button to shut down, but was
sometimes necessary.
o Turning it off without going through the full "Turn Off" procedure actually does no real
harm. But do not turn it immediately back on without waiting 10‐15 seconds.
 If the computer is fully "locked up" and will not respond to mouse or keyboard, sometimes a
"hard" shutdown is required.
o Hold down the Power button for as long as it takes for the computer to shut down (not
just blank out the monitor, but hear it shut off).
o Now when you restart it, things should be back to normal.
o This was probably due to a program waiting for something to happen, which was not
happening.
 Windows does have a program to stop just that problematic program (Task
Manager), but that is for a different discussion.
 The term "Icon" refers to a small graphical representation (picture) of a file, a program, or a
folder, specifically any object on a computer.
o It can be the actual file, program or document, or just a shortcut to the same.
 Note that any toolbar can be dragged off the taskbar and left "floating" anywhere on the
desktop. This is how strange bars of words or icons occur (just seemingly show up)
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Review of Displayed Components (Everything seen on the monitor or screen)
 The Desktop is everything you are looking at on the screen of the monitor when Windows first
starts up, above the taskbar (that line with the Start (or the Pearl) button on the left. An open
window is not your desktop, it is considered as on top of your desktop. The desktop includes
both the background (upon which the icons lay, often refer to as wallpaper) and the icons (see
below).
o This is where you traditionally place Shortcuts which open programs, files, or folders
used very frequently (or to which you wanted quick, easy access); or where you place
the actual files and/or folders, again for quick access. These are all represented by little
pictures called Icons.
 Under Windows XP and Vista, the trend was to place less icons on the desktop
background.
 Instead, they introduced a Quick Launch toolbar.
o The only difference between the icons representing shortcuts, and the
icons representing the actual files or folders (all programs are also files), is



that shortcuts have a small white square with a curved black arrow
in
the lower left corner (an example is on the right).
The actual files or folders do not have that shortcut arrow box.
o Deleting a shortcut removes only the "button" to get quickly to the actual
file/folder/program. The program or file is not removed. The button (shortcut) can be
easily replaced (recreated).
o By deleting the actual file, folder, or program, it is gone completely, and permanently.
o All those icons on the desktop, when double‐clicked, either open programs, files, or
folders. The actual file, folder, or program is opened, whether the icon represents the
original, or a shortcut to the original.
The Taskbar is the bar across the bottom of the screen containing at the far left, the Start
Button,
,
, or
which hovered over displays "Start") and at the far right,
the Notification area (previously called the System Tray) which contains several small icons
representing constantly running programs (in the background).
o Besides the Start button, the Taskbar confirms which window is (or windows are) open
by displaying a button for each open window. These occupy the middle (initially blank)
area of the Taskbar.
 You can switch from window to window (program to program) by clicking on
each program’s labeled button.
 A second click (not double‐click) on the same button "minimizes" the window
(shrinks the window to the taskbar only).
 Restore it to the screen with another click (or tap)
o The taskbar also contains a manila‐colored Folder. This icon opens File Explorer, which is
the App used to display and explore all Drives, Files, and Folders stored in the computer.
 Initially the icon opens to a display of Quick Access areas.
 But you can instead change a setting to make it open with This PC by opening
File Explorer, clicking on the View tab and at the far‐right end of the ribbon, click
on the Options button. Now at the top it says, "Open File Explorer to".
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Displayed Components of the Desktop (cont'd)
o The taskbar can also display (is capable of holding) many small icons just to the right of
the Start button as shortcuts to any program or App.
 Add (Pin) icons to the Taskbar for quick access by either dragging the program's
icon from the desktop or the Start menu, or by right‐clicking on the desired app
or application (program) icon in the Start Menu and hovering the mouse pointer
over More. When the side menu opens, choose (click on) "Pin to Taskbar".
 In a similar fashion, you can pin it to the larger Tiles in the right‐most port of
the Start menu by choosing "Pin to Start" from the right‐click menu of the
desired icon.
 "Toolbars" can also be placed on the Taskbar. These are Labeled button which
open a list of any desired Folder. Right‐click in a blank (no icon) area of the
Taskbar and choose Toolbars. Now either click one offered or click New Toolbar
to create your own.
 Any toolbar can be dragged off the taskbar and is then called "floating".
o The taskbar can be moved (to the sides or top), and resized.
 You may wish to have it larger (double line/layer of icons) if too many icons are
present.
 If you do not enlarge it, when too many icons are present, they may appear to
have disappeared. Windows has merely created a second layer hiding some of
them. At the right of the icons, there appears an Up‐Down Arrow which will
toggle between an upper line of icons or the lower line of icons.
 To resize the Taskbar, unlock it by right‐clicking a blank area and if there is a
check in front of Lock Toolbar, click on it.
 Now just move the mouse pointer to the edge of the Taskbar margin (on side
of Taskbar adjacent to the Desktop background). When you see it turn into a
double‐sided arrow, just drag upward with the mouse (assuming the Taskbar
is at the bottom).
o Icons on the far right (including clock) are in the Notification area. These icons have
special functions, or access to various Windows components. We will talk about this
during subsequent lessons. For the time being, just remember it is where the clock and
the volume control are located.
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How to use the Start button:
 The Start Button opens the Start Menu. The Start menu provides access to many things. With
the introduction of Windows 10 the Start menu has changed somewhat from that which users
have been accustomed. It works the same way, only better.
 The Windows XP through Windows 7 Start menu includes:
o All Programs (found at the bottom of the left Start menu pane), a list of shortcuts to all
the programs installed on your computer.
o My Computer (Just labeled Computer on Windows Vista & 7), a site with access to all
the drives on the computer.
o My Documents (Also just labeled Documents on Windows Vista & 7), where you store
the various things you create (letters, pictures, cards, etc.). You will learn all the things
you can create later.
o My Pictures (You guessed it, just labeled Pictures on Windows Vista & 7), another folder
within My Documents on Windows XP, separate folders on all versions of Windows
subsequent to XP, established by Windows, and designed to organize all photos or other
graphics you acquire.
o My Music (Again just labeled Music on Windows Vista & 7), where the files "ripped"
from a CD are stored.
o Control Panel, used to change settings and options, and uninstall (remove) programs.
 Windows 10 Start menu removed Control Panel, Computer, and User folders (Documents,
Pictures, Music, etc.).
o And instead provided Power, Settings (the substitute for Control Panel access), possibly
File Explorer (the program with which to look at any files on the computer), and User
Account (the place to sign out, switch users, or lock the computer if a password has
been set). Initially these appear only as icons, but in latest releases opens to Titles of
Power, etc.
o The Start Menu also displays just to the right of the Power, Settings, User Account, a list
displaying all the Applications (Programs) and Windows 10 Apps currently installed. This
list can be scrolled; or click on a displayed alphabet letter to jump to an area beginning
with the chosen alphabet letter.
o Windows 10 Start button also provides a right‐click menu providing quick access to
many of the Control Panel items for the more experienced computer user.
o Certain User folders can be restored to the Start menu if desired in Settings |
Personalize | Start.
 The Start button is where to go to view what programs (now referred to as applications) and
Apps (the simpler Windows 10 included Apps) are available on the computer (have previously
been installed, either by the manufacturer or yourself) by using the scrollable list mentioned
above.
 All installed programs/applications and Apps should appear somewhere on this list, either
individually or under Folders. Newly installed Apps and Applications (Programs) are listed in the
scrollable list as Recently Added.
 The Start button is where to go to open (launch) any installed program, particularly if no similar
icon is on the Desktop or Taskbar.
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Program Basics (We will discuss more about using an App or program (application) later, if you are not
ready yet.) Understand we will use program, application, or App interchangeably for our discussion.
 Opening a Program (otherwise called starting, launching, or loading a program)
o A Program opens either by:
 Double‐clicking an icon on the Desktop
 Single‐clicking a Quick Access icon (the Taskbar) or icon within the Start Menu.
 By double‐clicking a document previously made by a program. Not only does the
document open, but also the program it was created with.
o Be patient, some programs are quite involved and may take several seconds, or even
minutes to fully "load" (open). Never consider a program as failed or stalled, without
waiting at least five minutes.
 Though most load almost instantly.
 Closing a Program
o As above, click the X in the upper right‐hand corner.
o You can often also go to the File menu of the program and choose (click on) Exit.
 Sometimes the command on the File menu is labeled Close. If there are both
Close and Exit commands, Close usually closes only the active document, leaving
the program running (and a blank window, or another document also currently
open). Exit always closes the program.
 Saving a document created by a Program can be done by:
o Going to the File menu and choosing Save or Save As.
o Going to the Save icon on the program's toolbar.
o Again, usually, when closing a program, if the document has not been saved subsequent
to any changes (or thought to be new changes), it asks if you want to save it, giving you
one last chance.
o It is important to pay attention to where you are saving a document (file); and
remember later where you saved it.
 This is the most common cause for difficultly finding a document later, not
paying attention to where it is being saved.
 This is also why you try to use some logic deciding where to name and save it.
This makes finding it later easier.
 In later lessons you will discover Windows has provided some very strong tools
to hunt (search) for that missing file.
o Get in the habit of saving it within (My) Documents (or Pictures, Music, or similar), or
better still, a folder you have created within (My) Documents (or some similar constant
folder).
 Consistency is the procedure of saving helps recall when something has been
stored.
Save OFTEN! You can never save too often, only not often enough.
Just a note to avoid confusion, the File menu shows Save, and also has a Save As. What is the
difference? The first time you save a document (project) Save and Save As are the same thing. You give
the file a name and save it. Once it has been saved, when you make changes and try to save it again,
Save replaces the first "draft" of your project. The original is gone. Save As allows you to save the
changes as an entirely new document/project, keeping both versions.
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Shutting Down
 Shutting down Windows 10 is accomplished by one of three methods.
o Right‐click the Start button and choose
Shutdown (at the bottom of the quick
access menu, and then Shutdown (or
Restart if so desired).

o Open (click or tap) the Start button and choose
(click) Power, then Shutdown.



o Or if properly configured, just tap (do not hold
down) the Power button on the PC.
 It should go through the normal shutdown.
 If configured just to "Sleep", it will need to be configured to Shut down. If so, for
now, just ignore this option.
If "frozen" or "locked up" turn it off by the Power button!
o Hold the Power button down until it finally shuts down, not just blanks the screen.
 This is referred to as a hard shutdown.
 Remember the Power button during hard shutdown may have to be held for a
long time (sometimes seemingly an eternity).
o Although this does not really do any harm, it should not be the usual way of shutting
down.
 Except to lose anything not yet saved.

In the next lesson (Lesson 3), we will discuss more about using a program, with a word processing
program as the example, including how to manipulate the size location and appearance of a window
(that which opens when a program is loaded).
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